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Contact Us

If you have any comments, suggestions or questions regarding AVS4YOU programs or if you have a new feature that you feel 
can be added to improve our product, please feel free to contact us.

When you register your product, you may be entitled to technical support.

Technical Support

AVS4YOU programs do not require any professional knowledge. If you experience any problem or have a question, please refer 
to the AVS4YOU Programs Help. If you cannot find the solution, please contact our support staff.

Note: only registered users receive technical support. 

AVS4YOU staff provides several forms of automated customer support:

 AVS4YOU Support System
You can use the Support Form on our site to ask your questions.

 E-mail Support
You can also submit your technical questions and problems via e-mail to support@avs4you.com.

Note: for more effective and quick resolving of the difficulties we will need the following information: 

 Name and e-mail address used for registration 

 System parameters (CPU, hard drive space available, etc.) 

 Operating System 

 The information about the capture, video or audio devices, disc drives connected to your computer 

(manufacturer and model) 

 Detailed step by step describing of your action 

Please do NOT attach any other files to your e-mail message unless specifically requested by AVS4YOU.com 
support staff.

General information: info@avs4you.com

Technical support: support@avs4you.com

Sales: sales@avs4you.com

Help and other documentation: help@avs4you.com
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Resources

Documentation for your AVS4YOU software is available in a variety of formats:

In-product (.chm-file) and Online Help

To reduce the size of the downloaded software installation files the in-product help was excluded from the installation although 
you can always download it from our web-site for your convenience. Please, visit AVS4YOU web-site at 
http://www.avs4you.com/OnlineHelp/index.aspx to download the latest available version of the help executable, run it 
and install into the AVS4YOU programs folder. After that you will be able to use it through the Help menu of the installed 
AVS4YOU software.

Online Help include all the content from the In-product help file and updates and links to additional instructional content 
available on the web. You can find the Online Help at our web-site - http://www.avs4you.com/OnlineHelp/index.aspx. 
Please note, that the most complete and up-to-date version of AVS4YOU programs help is always on the web.

PDF Documentation

The offline help is also available as a pdf-file that is optimized for printing. All PDF help files are available for download at the 
programs pages at AVS4YOU web-site (both http://www.avs4you.com/index.aspx and 
http://www.avs4you.com/OnlineHelp/index.aspx). To be able to read and print AVS4YOU PDF help files you will need to 
have a PDF reading program installed.

User Guides

You have access to a wide variety of resources that help you make the most of your AVS4YOU software. The step-by-step user 
guides will be of help not only to the novice users but also to the users that face a certain task to be performed and look for a 
way to do it. Please, visit our User Guides section of AVS4YOU web-site at http://www.avs4you.com/Guides/index.aspx
to read the detailed instructions for various software and tasks

Technical Support

Visit the AVS4YOU Support web-site at http://support.avs4you.com to ask your questions concerning AVS4YOU software 
installation, registration and use. Feel free to also use our e-mail address support@avs4you.com.

Downloads

Visit the Downloads section - http://www.avs4you.com/downloads.aspx - of our web-site to find free updates, tryouts, 
and other useful software. We constantly update the software, new versions of the most popular programs and new software are 
also frequently released.
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Overview

Before introducing the program itself it's quite appropriate to mention what a slideshow actually means. When we hear this

word, the following picture comes into mind: a presenter using an apparatus, e.g. a slide projector or in more recent years a

computer running presentation software, is showing a series of chosen images.

But now it's becoming more common to see digital photo slideshows. Slideshows can be made using photos, music, wedding

invitations, birth announcements, or virtually any other documents that can be scanned. Some people call these DVDs or DVD

slideshows. Slideshows can be created not only in DVD, but also in HD video format and executable file for PC. As for the AVS

Slideshow Maker program, it produces slideshows in DVD format only.

Reading this help documentation will encourage you to make a successful slideshow presentation.

AVS Slideshow Maker is an easy to use application that lets you not only create slideshows and burn them to disc, but also

adjust the properties of every photo imported to the program. It's possible to set the duration of each photo, to change its

position within the slide palette as well as the image and color settings not to mention rotate the picture left or right.

With the AVS Slideshow Maker application you can create a complete photo slideshow project, including transitions between

the added pictures, album styles applied to photos, background music and DVD Menu. So it comprises a whole set of necessary

tools for you to excite your fantasy, achieve the best results and simply enjoy the process.

To launch AVS Slideshow Maker open the Start menu and select All Programs -> AVS4YOU -> Video -> AVS

Slideshow Maker.

Program Interface

The Main Window of the AVS Slideshow Maker program comprises the following components:

Main Menu - is used to get access to all the main functions and features of the program.

Top Toolbar - is used to get quick access to the basic features, such as working with projects, DVD compiling

commands as well as common information about the program.

Files and Styles Area - shows image and audio files and folders stored on your computer, available transitions, album

and DVD menu styles.

Preview Area - is used to preview the imported photos, album and DVD menu styles as well as the entire slideshow

with added background music.

Storyboard - is used to add, remove and manage photos, apply transitions between them, album styles as well as add

background music.

Albums List - displays albums with slideshow photos, along with applied styles and transitions, that will be written to a

disc.
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Main Menu

The AVS Slideshow Maker application can be operated with the help of Main Menu elements. Flexible system of menu

elements is a perfect tool for navigating and operating the application, controlling all the processes.

The Main Menu has the following structure:

File Menu Section

Item Shortcut Description

New Project Ctrl+N
Use it to start a new project, add new photos to your future slideshow albums,

edit them and write onto a disc.

Open Project Ctrl+O
Use it to open a previously saved project to edit it or write slideshow albums onto

a disc.

Save Project Ctrl+S Use it to save the currently edited project.

Save Project as...
Shift+Ctrl

+S
Use it to save the currently edited project under a different name.

Recent Projects
Use it to open a previously saved project that is displayed in the list of the recently

opened/saved projects.
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Build DVD Use it to start DVD creation and burning it onto a disc.

Exit Use it to finish work with AVS Slideshow Maker and exit.

Edit Menu Section

Item Shortcut Description

Rotate Left Ctrl+L
Use it to change the orientation of the imported photo (portrait to landscape and

vice versa).

Rotate Right Ctrl+R
Use it to change the orientation of the imported photo (portrait to landscape and

vice versa).

Remove Del Use it to remove the photo selected on the Storyboard.

Remove All Ctrl+Del Use it to remove all the photos present on the Storyboard.

Edit Ctrl+E

Use it to edit imported photos - adjust color settings, duration, position - as well as

rotate them, add transitions between the images, text captions and album

styles.

View Menu Section

Item Description

Photos
Use it to change the view of the Files and Styles Area to be able to find image files stored on

your PC in order to add them to the Storyboard.

Transitions
Use it to change the view of the Files and Styles Area to be able to add transitions between

imported photos to the Storyboard.

Background Music
Use it to change the view of the Files and Styles Area to be able to find audio files stored on

your PC in order to add them to the Storyboard as background music for your slideshow.

Album Style
Use it to change the view of the Files and Styles Area to be able to add available album styles

to the photos present on the Storyboard.

DVD Menu
Use it to change the view of the Files and Styles Area to be able to select a DVD menu style

for the DVD where the created slideshows will be burnt to.

Aspect Menu Section

Item Description

4 x 3

This aspect ratio is used to change the aspect ratio of your resulting slideshow so that it could

fit a common CRT or 4:3 LCD display without any distortions and without black mattes in the

upper and lower parts of the slideshow.

16 x 9

This aspect ratio is used to change the aspect ratio of your resulting slideshow so that it could

fit a widescreen 16:9 LCD display without any distortions and without black mattes on sides of

the slideshow.
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Help Menu Section

Item Shortcut Description

Help F1 Use it to open the AVS Slideshow Maker help file.

AVS4YOU on the Web Use it to visit AVS4YOU web site.

About
Use it to read the information about the AVS Slideshow Maker program or to

contact our support staff per e-mail.

Top Toolbar

The Top Toolbar lets the user to access quickly the program main functions and consists of the following buttons:

Button Name Description

New Project
Is used to start a new project, add new photos to your future slideshow albums,

edit them and write onto a disc.

Open Project
Is used to open a previously saved project to edit it or write slideshow albums

onto a disc.

Save Project Is used to save the currently edited project.

Build DVD Is used to start DVD creation and burning it onto a disc.

Settings
Is used to adjust settings of the current project - you can select video system,

DVD profile, aspect ratio, disc type.

About
Is used to read the information about the AVS Slideshow Maker program or to

contact our support staff per e-mail.

Files and Styles Area

The Files and Styles Area shows image and audio files and folders stored on your computer, available transitions, album and

DVD menu styles. It consists of five Tabs situated in the upper part of the area:

Photos Tab - is used to find image files stored on your computer hard disk drive or a storage medium in order to create

a slideshow on their basis.

Transitions Tab - is used to represent all the available transitions for you to select and apply in your slideshow.

Background Music Tab - is used to find audio files stored on your computer hard disk drive or a storage medium in

order to employ them as background music in your slideshow.

Album Style Tab - is used to represent all the available album styles for you to select and apply in your slideshow.

DVD Menu Tab - is used to display all the available DVD menu styles for you to select and apply for your DVD where

the created photo slideshows will be burnt to.
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Three of these tabs have their own Toolbar helping to find or sort objects that are present in the Display Area.

Photos Tab

The Photos Tab of the Files and Styles Area will be seen at once as soon as you start AVS Slideshow Maker. It is used to

find image files stored on your computer hard disk drive or a storage medium in order to create a slideshow on their basis:
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Toolbar

In the table given below you can find the function description of each Toolbar element of the Photos Tab.

Button Name Description

Back Is used to navigate through the folders opened before.

Next
Is used to navigate through the folders opened before. It becomes available

only after the Back button was pressed.

Level Up
Is used to go to the level parent for the current one. Within the Display Area

there is a button with the same function.

Folder Tree
Is used to see the entire folder structure on your computer. To do that click the

button.

Thumbnail Size

Is used to change the size of thumbnails that represent the folders and files

shown in the Display Area. By moving the indicator along the slider you can

set the size you need.

Auto
Is used to set a standard value for the Thumbnail Size. After checking this

box you won't be able to use the slider for size adjustment.

Express Menu

The Photos Tab has also its own Express Menu that is used to facilitate the access to the main functions of the program. It

can be accessed by right-clicking an element in the Display Area. It comprises the following items:

Open - use it to open the selected folder. It's unavailable if a file is right-clicked.

Add - use it to import the selected file to the Storyboard.

Add All - use it to add all the files seen in the Display Area to the Storyboard.

Level Up - use it to go to the level parent for the current one.

View Style - use it to choose the view of objects present in the Display Area among the

following types: icon, preview, preview with info.

Arrange - use it to sort the files and folders in the Display Area by name, size, file type, creation

or modification date.

Properties - use it to open the Properties window where all the properties of the selected image

file are displayed. This option is not available if a folder is right-clicked.

Image File Properties Window

This window can be opened by right-clicking a file in the Display Area

and selecting the Properties option from the Express Menu. Here

you can find the following information:

File

File Name - name of the selected file

File Size - size of the file (given in Kb or Mb)

Modified - date of the latest file modification

(year:month:day and hours:minutes:seconds)

Image

Width - image width (given in pixels)

Height - image height (given in pixels)
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Transitions Tab

The Transitions Tab is the second one in the Files and Styles Area. It is used to represent all the available transitions for

you to select and apply in your slideshow and looks like this:

Toolbar

The Toolbar of the Transitions Tab comprises only one item, namely Category, that

is used to sort objects present in the Display Area. So you can easily find a wanted

transition if you know to what group it belongs.

There are the following groups in this drop-down list: enhanced, transform, rotate, swing, shatter, diffuse, page, fade, mosaik.

Express Menu

The Transitions Tab has also its own Express Menu that is used to facilitate the access to the main functions of the program.

It can be accessed by right-clicking an element in the Display Area. It comprises the following items:

Apply - use it to apply the right-clicked transition to the selected palette between two

photos on the Storyboard.

Apply to All - use it to apply the right-clicked transition to all the palettes between the

photos.

Apply Randomly - use it to apply random transitions to all the transition palettes on the

Storyboard.
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Background Music Tab

The Background Music is the third one in the Files and Styles Area. It is used to find audio files stored on your computer

hard disk drive or a storage medium in order to employ them as background music in your slideshow and looks like this:

Toolbar

In the table given below you can find the function description of each Toolbar element of the Background Music Tab.

Button Name Description

Back Is used to navigate through the folders opened before.

Next
Is used to navigate through the folders opened before. It becomes available

only after the Back button was pressed.

Level Up
Is used to go to the level parent for the current one. Within the Display Area

there is a button with the same function.

Folder Tree
Is used to see the entire folder structure on your computer. To do that click the

button.

© Online Media Technologies Ltd., UK 2004 - 2009   All rights reserved. www.avs4you.com

AVS4YOU Programs Help - AVS Slideshow Maker Page 11 of 46

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


Express Menu

The Photos Tab has also its own Express Menu that is used to facilitate the access to the main functions of the program. It

can be accessed by right-clicking an element in the Display Area. It comprises the following items:

Open - use it to open the selected folder. It's unavailable if a file is right-clicked.

Level Up - use it to go to the level parent for the current one.

Add - use it to import the selected file to the Storyboard.

Arrange - use it to sort the files and folders in the Display Area by name, size, file type, creation

or modification date.

Properties - use it to open the Properties window where all the properties of the selected file

are displayed. This option is not available if a folder is right-clicked.

Audio File Properties Window

This window can be opened by right-clicking a file in the Display Area and selecting the Properties option from the Express

Menu. Here you can find the following information:

File

File Name - name of the selected file

File Size - size of the file (given in Kb or Mb)

Modified - date of the latest file modification

(year:month:day and hours:minutes:seconds)

Audio

Channels - number of audio channels

Sample rate - number of samples per second taken

from a continuous signal to make a discrete signal

(kilohertz)

Bitrate - number of bits transferred per second (Kb per

second)

Codec - codec used to create this audio file

Duration - total duration of the audio track

(hours:minutes:seconds.milliseconds)
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Album Style Tab

The Album Style Tab is the fourth one in the Files and Styles Area. It is used to represent all the available album styles for

you to select and apply in your photo slideshow and looks like this:

Express Menu

The Album Style Tab has also its own Express Menu that is used to facilitate the access to the main functions of the

program. It can be accessed by right-clicking an element in the Display Area. It comprises the following items:

Apply - use it to apply the right-clicked album style to the selected photo on the

Storyboard.

Apply to All - use it to apply the right-clicked album style to all the photos.

Apply Randomly - use it to apply random album styles to all the photos on the

Storyboard.
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DVD Menu Tab

The DVD Menu Tab is the fifth one in the Files and Styles Area. It is used to display all the available DVD menu styles for

you to select and apply for your DVD where the created photo slideshows will be burnt to and looks like this:

Express Menu

The DVD Menu Tab has also its own Express Menu that is used to facilitate the access to the main functions of the program.

It can be accessed by right-clicking an element in the Display Area. It comprises the following items:

Apply Menu Preset - use it to apply the right-clicked DVD menu style to the current

slideshow project.
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Preview Area

The Preview Area is used to preview the photo and audio files situated on the Storyboard as well as DVD Menu and playback

the resulting slideshows.

Use the controls to preview the photos and navigate through the whole slideshow:

Button Name Description

Playback
Is used to start slideshow playback. Once you click it, it will turn into the Pause button to let

you pause the playback when needed. The slider cursor will stay at its current position.

Stop
Is used to stop slideshow playback. After pressing this button the slider cursor will return to its

initial position.

Frame Back Is used to step one photo back in the slideshow.

Frame

Forward
Is used to step one photo forward in the slideshow.

Snapshot
Is used to take a snapshot of the current moment of the slideshow and save it into one of the

supported image file formats.

Mute

Is used to switch the sound of the played video off if you added audio files to the Storyboard

as background music. As soon as you pressed this button it turns into the Unmute button for

you to switch the sound on if needed.

Volume Is used to change the sound volume while the video is played back.
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You can also change the playback speed moving the cursor of the Playback Speed slider - , the speed value is

displayed next to the slider.

Value Description

from -16x to -2x If you set this value, the backward playback speed will be increased

-1x If you set this value, your slideshow will be played backwards at normal speed

from -0,5x to 0x If you set this value, the backward playback speed will be decreased

from 0x to 0,5x If you set this value, the forward playback speed will be decreased

1x If you set this value, your slideshow will be played forwards at normal speed

from 2x to 16x If you set this value, the forward playback speed will be increased

Note: if the cursor of the playback slider reaches the beginning of the slideshow, when the negative

speed value is set, the player continues to play back slideshow at normal speed (+1x).

To quickly navigate through your slideshow use the Playback slider - .

Storyboard

The Storyboard is situated at the bottom of the AVS Slideshow Maker main window and used to add, remove and manage

photos, apply transitions between them, album styles as well as add background music.

The Storyboard consists of the following elements:

Toolbar - is used to perform main operations with storyboard objects, such as photos, audio files, transitions, etc. and

can vary depending on the pressed tab of the Files and Styles Area.

Slide Palette - presents a location on the Storyboard for an image file added from the Files and Styles Area.

Transition Palette - offers a location on the Storyboard for a transition added from the Files and Styles Area.

As already mentioned, the Storyboard can change its appearance depending on what Tab in the Files and Styles Area is

opened. Therefore it might be useful to read the next sections where each of the storyboard views is introduced. The special

case is the Storyboard area when the Background Music tab is pressed, as it turnes into a Timeline.

Note: the Storyboard has no toolbar and express menu when the DVD Menu Tab is pressed.
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Storyboard with Photos Tab Pressed

As follows from the title, all the operations that can be performed within the Storyboard when the Photos Tab is pressed are

related to image files. In this particular case the Storyboard will look like this:

The Storyboard has its Toolbar. The description of the toolbar buttons can be found in the table below.

Toolbar

Button Name Description

Add
Use this button to add the photo selected in the Files and Styles Area to the

Storyboard.

Add All
Use this button to add all the photos displayed in the Files and Styles Area to

the Storyboard.

Remove Use this button to remove the photo selected on the Storyboard.

Remove All Use this button to remove all the photos from the Storyboard.

Rotate Left
Use this button to rotate the photo selected on the Storyboard

counterclockwise.

Rotate Right Use this button to rotate the photo selected on the Storyboard clockwise.

Edit
Use this button to open the Edit window in order to adjust the properties of the

photo selected on the Storyboard.

Express Menu

The storyboard has also its own Express Menu that is used to facilitate the access to the main functions of the storyboard. It

can be accessed by right-clicking an object present on the Storyboard. The Express Menu comprises the following items:

Remove - this option corresponds to the toolbar button of the same name and is used to remove the selected photo

from the Storyboard.

Remove All - this option corresponds to the toolbar button of the same name and is used to remove all the photos from

the Storyboard.
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Rotate Left - this option corresponds to the toolbar button of the same name

and is used to rotate the photo selected on the Storyboard counterclockwise.

Rotate Right - this option corresponds to the toolbar button of the same name

and is used to rotate the photo selected on the Storyboard clockwise.

Edit - this option corresponds to the toolbar button of the same name and is

used to open the Edit Photos window in order to adjust the properties of the

photo selected on the Storyboard.

Properties - is used to open the Properties window where all the properties of

the selected image file are displayed. Please find the description of the

window elements here.

Note: some of the Express Menu options can be unavailable depending on the place within the

Storyboard that you right-clicked (slide or transition palette).

Storyboard with Transitions Tab Pressed

As follows from the title, all the operations that can be performed within the Storyboard when the Transitions Tab is pressed

are related to transitions. In this particular case the Storyboard will look like this:

The Storyboard has its Toolbar. The description of the toolbar buttons can be found in the table below.

Toolbar

Button Name Description

Apply
Use this button to add the transition selected in the Files and Styles Area to the

Storyboard.

Apply to All
Use this button to add all the transitions displayed in the Files and Styles Area

to the Storyboard.

Apply Randomly Use this button to add random transitions to the Storyboard.

Edit
Use this button to open the Edit window in order to adjust the properties of the

photo selected on the Storyboard.
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Express Menu

The storyboard has also its own Express Menu that is used to facilitate the access to the main functions of the storyboard. It

can be accessed by right-clicking an object present on the Storyboard. The Express Menu comprises the following items:

Apply - this option corresponds to the toolbar button of the same name and is used to

add the transition selected in the Files and Styles Area to the Storyboard.

Remove - is used to remove the selected photo from the Storyboard.

Remove All - is used to remove all the photos from the Storyboard.

Edit - this option corresponds to the toolbar button of the same name and is used to

open the Edit Photos window in order to adjust the properties of the photo selected on

the Storyboard.

Properties - is used to open the Properties window where all the properties of the

selected image file are displayed. Please find the description of the window

elements here.

Note: some of the Express Menu options can be unavailable depending on the place within the

Storyboard that you right-clicked (slide or transition palette).

Storyboard with Background Music Tab Pressed

As follows from the title, all the operations that can be performed within the Storyboard when the Background Music Tab is

pressed are related to audio files. In this special case Storyboard will look as follows:

Timeline

This view of the Storyboard area is called Timeline, as it represents a time scale at its top and offers a possibility to navigate

through your slides by dragging a cursor.

All the image files are situated in the Slides line representing a filmstrip, and added audio tracks are displayed in the Audio

Tracks line, one below the other. So, you can easily see how many slides are covered by added audio track.

The Audio Track line comprises audio tracks represented as waves. If the audio file you

added to the Timeline is stereo it will be seen on it as two blue waves according to the

number of channels. The green line is the level of sound volume in the audio track that

can be changed. As soon as you select an audio track on the timeline by clicking it, the green line will become red and the whole

audio track will be enclosed in yellow 'brackets' (see the figure above). To read more about how to change the volume level in

your audio track and trim it, click here.

The Timeline has its own Toolbar. The description of each toolbar button can be found in the table below.
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Toolbar

Button Name Description

Add button
Use this button to add the audio file selected in the Files and Styles Area to the

Storyboard.

Remove button Use this button to remove the audio file selected on the Storyboard.

Remove All button Use this button to remove all the audio files from the Storyboard.

Zoom In button
Use this button to zoom in the selected part of the slideshow to find a certain

photo.

Zoom Out button
Use this button to zoom out the selected part of the slideshow to find a certain

photo.

Zoom to Fit button Use this button to recover the 100% view.

Slides icon In this line all the slides, along with transitions, are displayed.

Audio Tracks icon Within this line the added audio files are displayed.

Slides Navigation
Use this scale to find a certain slide in your show. The scale division is represented

in hh:mm:ss.tt (hours:minutes:seconds.thousandths of seconds).

Express Menu

The storyboard has also its own Express Menu that is used to facilitate the access to the main functions of the storyboard. It

can be accessed by right-clicking an object present on the Storyboard. The Express Menu comprises the following items:

Reset Envelope - is used to set sound volume of the added audio track to the original state.

Remove - is used to remove the selected audio track from the Storyboard.

Remove All - is used to remove all the audio tracks from the Storyboard.

Properties - is used to open the Properties window where all the properties of the selected

audio file are displayed. Please find the description of the window elements here.
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Storyboard with Album Style Tab Pressed

As follows from the title, all the operations that can be performed within the Storyboard when the Album Style Tab is

pressed are related to image files. In this particular case the Storyboard will look like this:

The Storyboard has its Toolbar. The description of the toolbar buttons can be found in the table below.

Toolbar

Button Name Description

Apply
Use this button to add the album style selected in the Files and Styles Area to

the photo marked on the Storyboard.

Apply to All
Use this button to add the album style selected in the Files and Styles Area to

all the photos on the Storyboard.

Apply Randomly
Use this button to add random album styles to each of the photos on the

Storyboard.

Clear
Use this button to remove applied album style from the photo selected on the

Storyboard.

Clear All
Use this button to remove applied album styles from all the photos on the

Storyboard.

Edit
Use this button to open the Edit window in order to adjust the properties of the

photo selected on the Storyboard.

Express Menu

The storyboard has also its own Express Menu that is used to facilitate the access to the main functions of the storyboard. It

can be accessed by right-clicking an object present on the Storyboard. The Express Menu comprises the following items:

Clear - this option corresponds to the toolbar button of the same name and is used to remove

applied album style from the selected photo on the Storyboard.

Clear All - this option corresponds to the toolbar button of the same name and is used to

remove applied album styles from all the photos present on the Storyboard.

Edit - this option corresponds to the toolbar button of the same name and is used to open the

Edit Photos window in order to adjust the properties of the photo selected on the Storyboard.
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Properties - is used to open the Properties window where all the properties of the selected image file are displayed.

Please find the description of the window elements here.

Note: some of the Express Menu options can be unavailable depending on the place within the

Storyboard that you right-clicked (slide or transition palette).

Albums List

The Albums List is a part of the AVS Slideshow Maker main window and is

situated at its bottom. It displays albums with slideshow photos, along with applied

styles and transitions, that will be written to a disc. Here you can create as many

albums as possible - the main point is that all of them should fit to the disc selected in

the Project Settings window.

Toolbar

Button Name Description

New Album
Use this button to add a new album to the

Albums List.

Remove

Album

Use this button to remove selected album from

the Albums List.

Express Menu

New Album - this option corresponds to the toolbar button of the same name and is

used to add a new album to the albums list.

Rename - use this option to give the album selected in the list a different name.

Remove Album - this option corresponds to the toolbar button of the same name

and is used to remove selected album from the albums list.
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Working with AVS Slideshow Maker: Overview

It's very easy to work with AVS Slideshow Maker, as each step in the workflow is quite predictable:

1. Firstly, start the application. Each time you do this a new untitled project will be automatically created. If you'd like to

continue working on an existing project you saved previously, open it. If you changed your mind and decided to

create a new project, you can do this any time.

2. Then produce your slideshows you want to burn to disc. This step includes such operations as organizing albums,

adding image files, transitions between them, background music, and editing imported slides.

3. Finally, select a DVD Menu style, build your DVD and burn your albums with slideshows to a disc.

Working with Projects

The work in AVS Slideshow Maker is built on the projects concept. It means that you can easily save the results of your work

and load them for creating additional DVD copies of your slideshow project any other time you need them.

Projects are also very useful in case you do not have a possibility to add and edit image files as well as compile DVD and burn

slideshow albums to disc all at once. If this is your case, you will need to save the project and next time start from the place

where you left your editing.

The project file represents a data file with a .shp extension containing the information on the image and audio files, transitions

and album styles added to your slideshow. You don't need to read the saved project with a third-party application, only AVS

Slideshow Maker is able to open (or reopen) the created project file.

Note: it's strongly recommended not to change the location of the image and audio files used in your

project while working on it.

The work with projects comprises the following:

Start Phase

If you launch the application for the first time, a new untitled project will be automatically created. Next time you

start it the previously edited project will be opened.

You can also create a new project if you completed your work on the previosly opened one.

It's also possible to open another existing project.

Middle Phase

After that you can adjust project settings - change video system, select quality, aspect ratio and disc type.

End Phase

On this final step save the edited project to be able to continue working on it next time.

Creating a New Project

So, when AVS Slideshow Maker is launched for the first time, a new project will be automatically created for you. But

you can create a new project yourself. To do that click the New Project button on the Top Toolbar or select the

appropriate option in the File section of the Main Menu.
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You will be asked if you want to save the previous project or not:

It is recommended to save the changes, so that you could use the project in future. Or you might want to press Cancel if you

do not plan to close the previous project and start a new one.

After the new project is created, you will need to change its settings and save it afterwards.

Opening an Existing Project

To edit an old project that has been previously saved you will need to open it. Click the Open Project button on

the Top Toolbar or select the appropriate option in the File section of the Main Menu. The following window will

be opened:

Select the necessary project and click the Open button. The project will be loaded into AVS Slideshow Maker reflecting all

the applied and saved changes.

You can also open one of the recently modified projects using the Recent Projects option of the File section of the Main

Menu and selecting the necessary project from the list of available ones.
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Adjusting Project Settings

You can view and change the project main settings using the Settings button of the Top Toolbar. The following

window will be opened:

Here you can select the following parameters:

System - use this option to select a the TV system used in your country (PAL or NTSC). You should select a PAL (for

Europe) or NTSC (for Japan and Americas). Please make sure that your DVD player and TV set support the selected DVD

system.

Quality - use this option to select a correct preset that will help you record a DVD with good quality, depending on the

total length of all slideshows you would like to include into your DVD. Normally you should select a High Quality DVD if

its total duration will be no more than 60 minutes for a single layer DVD (108 minutes for a double layer DVD). Selecting

a Long Play DVD cannot be really recommended and should be used only in case you really need to use it as the quality

of the output DVD will be not optimal. Depending on the preset chosen the settings below it will be changed as follows:

1. Video Settings - will be changed, some of them depending on the quality preset and will include:

Aspect - select it from the drop-down box depending on the display type (4:3 (LCD or CRT) or 16:9

LCD).

Frame Size - the size of the slides in pixels that depends on the preset selected and will always be

720x480 for an NTSC DVD and 720x576 for a PAL DVD.

Frame Rate - the number of frames displayed per second that depends on the preset selected and will

always be 29.97 fps for an NTSC DVD and 25 fps for a PAL DVD.

Bitrate - the bit transfer rate that depends on the preset selected and will be 9400 kbps for a High

Quality NTSC or PAL DVD, 6200 kbps for a Good Quality NTSC or PAL DVD, 4600 kbps for a Standard

Quality NTSC or PAL DVD, 2150 kbps for a Long Play NTSC DVD and 2300 for a Long Play PAL DVD.

2. Audio Settings - will always stay the same for all types of DVDs:

Sample Rate - sampling frequency specified in kilohertz. Will always be 48 kHz.

Sample Size - will always be 16-bit.

Number of Channels - the number of channels in the audio track. Will always be 2 channels.

Bitrate - the number of data points used to approximate the true wave form (kilobits per second). Will

always be 224 kbps.
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Disc Usage - the space occupied by the albums with slideshows on the selected disc type (single or double layer) with

the specified above quality preset.

Note: if you select a double layer DVD, make sure that your DVD drive supports writing onto such

discs.

To accept all the changes you've made click the Done button, to discard changes and close the Project Settings window click

the X button in the top right corner of the window.

Saving a Project

Whenever a new project is created or you edit an old project, you will need to save it so that all the changes were

available in the future. Click the Save Project button on the Top Toolbar or select the appropriate option in the File

section of the Main Menu. The following window will be opened:

Select the location, enter the project name and click the Save button. The next time you need to edit the same project, simply

open it.

In case you need to save the same project but under a different name use the Save Project as... option of the File section of

the Main Menu.
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Producing Slideshows

The process of producing slideshows consists of the following steps:

1. Create albums for your image files and give them titles.

2. After that add your image files to the storyboard and arrange their sequence.

3. Now you can give free rein to your imagination. Apply transitions, add background music, edit imported photos -

rotate them, adjust their duration, position as well as color and picture properties, - add text to certain slides or all of

them.

Organizing Albums

It makes sense if you start producing slideshows with creating and organizing albums,

thus you can better plan the contents of the disc you want to create. Of course, it can

comprise one and only album if all the slides correspond to the same topic. But if not,

you can arrange all the slides in albums according to their topic.

So, when you launch AVS Slideshow Maker, an album will be automatically created

for you under the Album 1 title. You can easily give another name to it by left-

clicking the album title once and entering the name you wish into the appeared field

(see the figure on the left) or using the Rename option of the Express Menu.

If you'd like to burn more than only one album to DVD you can add more albums

hitting the button or using an appropriate option of the Express Menu. In the

similar way you can delete unnecessary albums from the Albums List clicking the

button.

As soon as you start adding image files to the storyboard, instead of the sign you will see thumbnail of the first slide in the

album.
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Adding Photos to the Storyboard

Browsing for Directory

Before you import image files to the program, you need to find the directory where photos you want to add are stored. For this

purpose use the Folders Tree drop-down list on the Photos Tab toolbar. You can add image files not only from your computer

hard disk drive, but also from any removable drive. Press the button to go to a level parent for the opened one. You can

also navigate through your system using the and buttons. In order to find a needed folder more easily or to see images

better, you can zoom in or out icons situated in the Display Area by dragging the cursor on the Thumbnail Size slider.

Adding Images

When you find a folder with necessary image files, add them to the Storyboard. Within AVS Slideshow Maker you can use

one of four ways of doing it. They are:

1. With a double-click

Direct the mouse cursor to an image file thumbnail in the Display Area, left-click it twice and in a few seconds it will

take place in the first Slide Palette.

2. Using storyboard toolbar

Click the image you want to add in the Display Area and then press the button on the Storyboard Toolbar.

3. Using express menu

Right-click the image you want to add in the Display Area and select the Add option in the opened Express Menu.

4. By dragging and dropping

Left-click the image you want to add in the Display Area, drag it to the storyboard and drop within a certain Slide

Palette.
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It's also possible to add all the image files from the chosen folder to the Storyboard using two of the ways described above -

hitting the button on the Storyboard Toolbar or selecting the Add All option of the Express Menu.

If you want to place an image on a certain palette in an existing slides sequence, click this slide palette once on the Storyboard

to mark it and double-click the necessary image in the Display Area. So, it will be placed on the marked palette followed by the

slide previously situated here.

Note: It's only possible to add files to the storyboard one by one thus arranging a slides sequence, i.e.

you can't leave a slide palette empty within a sequence. So, after adding an image only the next slide

palette will be available for placing an image there.
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Removing Images from the Storyboard

There are three ways to remove slides from the storyboard:

1. Using storyboard toolbar

Click a slide on the storyboard and press the button on the Storyboard Toolbar.

2. Using express menu

Click a slide on the storyboard and select the Remove option of the Express Menu.

3. Using keyboard

Click a slide on the storyboard and press the Del key on your computer keyboard.

It's also possible to remove all the slides from the Storyboard using one of the ways described above - hitting the button

on the Storyboard Toolbar, selecting the Remove All option of the Express Menu, or using the Ctrl+Del keys combination.

Applying Transitions

While adding images one by one they will appear on the Storyboard and a default transition type will be automatically used

between images to let one image smoothly turn into another. AVS Slideshow Maker offers you quite a number of transitions.

They can be found on the Transitions Tab of the files and styles area.

You might want to apply a specific transition between certain slides on the storyboard. To do it click the Transitions Tab and

find a transition you want to add. In order to facilitate the searching process there is the Category drop-down list on the tab

toolbar where you can choose one of the transition types to be shown within the Display Area.

Within AVS Slideshow Maker you can use one of three ways of doing it. They are:

1. Using storyboard toolbar

Click the transition palette you want to change, then the transition you want to apply instead of the default one in the

Display Area and press the button on the Storyboard Toolbar.

2. Using express menu

Left-click the transition palette you want to change, right-click a transition you want to apply in the Display Area and

select the Apply option in the opened Express Menu.

3. By dragging and dropping

Left-click the transition you want to apply in the Display Area, drag it to the storyboard and drop within a certain

Transition Palette.
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It's also possible to apply the same transition type to all of the images added to the Storyboard using two of the ways

described above - hitting the button on the Storyboard Toolbar or selecting the Apply to All option of the Express

Menu.

If you'd like to apply random transitions, click the button on the storyboard toolbar or use the appropriate option of the

Express Menu. So, in each transition palette a different transition will be situated.

You can also set duration for a certain transition or all of them within the Edit Photos window. Please read the Changing

Properties of Single Photos chapter to learn more about it.
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Adding Background Music

While creating a slideshow project you can't go without background music. Using it you can communicate mood or give a certain

message to people who will watch your slideshows.

Browsing for Directory

Before you import audio files to the program, you need to find the directory where your music you want to add is stored. For this

purpose use the Folders Tree drop-down list on the Background Music Tab toolbar. You can add audio files not only from

your computer hard disk drive, but also from any removable drive. Press the button to go to a level parent for the opened

one. You can also navigate through your system using the and buttons.

Adding Audio Files

Within AVS Slideshow Maker you can use one of three ways to add background music. They are:

1. Using storyboard toolbar

Click the audio file you want to add in the Display Area and then press the button on the Timeline Toolbar.

2. Using express menu

Right-click the audio track you want to add in the Display Area and select the Add option in the opened Express

Menu.

3. By dragging and dropping

Left-click the audio file you want to add in the Display Area, drag it to the storyboard and drop within a certain area, as

shown in the figure below.
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Note: you can add as many audio tracks as you want depending on the duration of your slideshow.

Removing Audio Tracks from the Storyboard

There are three ways to remove added audio tracks from the storyboard:

1. Using storyboard toolbar

Click the audio track on the storyboard and press the button on the Storyboard Toolbar.

2. Using express menu

Click the audio track on the storyboard and select the Remove option of the Express Menu.

3. Using keyboard

Click the audio track on the storyboard and press the Del key on your computer keyboard.

It's also possible to remove all the audio tracks from the Storyboard using one of two ways described above - hitting the

button on the Storyboard Toolbar or selecting the Remove All option of the Express Menu.
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Changing Position of Audio Track

The added audio track is placed within the appropriate line

and covers only a certain area of the slideshow on the

Timeline depending on its original duration. To set the

position you want you should direct the mouse cursor to

the audio track situated on the timeline. The mouse cursor

turns to a hand . By left-clicking the effect and moving

the hand cursor to the left or to the right you can change

the position of the added track within the line.

Changing Duration of Audio Track

It's also possible to change duration of the imported

audio track. To do that you should direct the mouse cursor

to one of the yellow stripes that bound the audio track. The

mouse cursor turns into a horizontal double-sided arrow .

Moving it to the left or to the right you can extend or

narrow limits of the audio track.

In case you extend its limits the music will be played

back from the very beginning once again regardless of the

direction you dragged the arrow. At the border between two

copies of the same audio track a control point (red dot) will appear. If you narrow the audio track limits, the part of it will be

cut off.

To find the exact place where you want the music to start playing and end, use the Preview Area situated on the right-hand

side.

Changing Volume Level in Audio Track

The red line represents volume level in your audio track.

If you'd like to change it, direct the mouse cursor to it and

you will see the cursor turn into a vertical double-sided

arrow . You can lift or lower the red line to increase or

reduce the volume level.

If you changed the duration of added audio track and

control points (red dots) appeared on the timeline, you

can lift or lower them and even move to the right or left

creating a unique volume curve in this way. To do this

direct the mouse cursor to one of the control points, it will be bounded by a square .

If you dislike the changes you have just made, right-click the audio track on the timeline and select the Reset Envelope option

of the Express Menu. So, the volume level will return to its dafault state and all the control points will disappear.
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Editing Photos

There are a lot of editing operations you can perform within AVS Slideshow Maker, such as:

rotating imported image files;

applying album styles;

adding text to single slides;

changing color and image properties of single slides.

The description of each operation can be found in the next sections.

Rotating Photos

After adding image files to the Storyboard you can rotate them if needed. You can do this in one of the following ways:

1. Using storyboard toolbar

Click the slide you want to rotate on the storyboard and then press the Rotate Left button or Rotate Right

button .

2. Using express menu

Right-click the slide you want to rotate on the storyboard and select the Rotate Left or Rotate Right option of the

Express Menu.

3. Pressing the Edit button

Click the slide you want to rotate on the storyboard and then press the Edit button or use the appropriate option of

the Express Menu. After that the following window will be opened:
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Applying Album Styles

Album Styles allow your slides to look like an album. So, watching such a slideshow you'll get the impression of turning over

the pages of your photo album, especially if you apply the same album style to all of the slides. But of course, it's also possible

to add a different album style to each slide what will add individuality to every single photo.

Note: after applying an album style to a photo it will cover a part of it, but you can adjust image

position within the slide palette. To read more on it, click here.

Adding Album Styles

To apply an album style you should click the Album Style Tab to open it. In the Display Area you can choose an album style

you like best. After that you can follow one of the methods described below to add the style to a slide:

1. Using drag-and-drop function

Click a style which you want to apply in the Display Area, drag it to the storyboard and drop it within any slide palette,

as shown in the figure below.
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2. Using storyboard toolbar

Mark the slide palette, which you want to apply one of the album styles to, by left-clicking it. Click an album style situated

in the Display Area. After that hit the button on the Storyboard Toolbar. If you'd like to apply the chosen style

to all of the slides on the storyboard, press the button. To apply random album styles to all of the slides on the

storyboard, use the button.

3. Using express menu of the Files and Styles Area

Click a slide on the storyboard you want to apply an album style to. Right-click the desired album style in the Display

Area of the Files and Styles Area and select the Apply option of the Express Menu. If you want to apply the chosen

style to all of the slides on the storyboard, choose the Apply to All option. To apply random album styles to all of the

slides on the storyboard, use the Apply Randomly option of the same express menu.

4. Selecting the Edit option of the storyboard express menu

Right-click a slide on the storyboard you want to apply an album style to and select the Edit option of the Express

Menu. The window displayed in the figure below will appear. Click the Style tab on the right-hand side, choose any

album style and press the Apply button. After that hit the Done button to close the Edit window.

Note: use the and buttons to go to the previous and next slide situated on the storyboard.

Removing Album Styles

If you dislike the appearance of your slide after applying an album style, you can remove it in one of the following ways:

1. Using storyboard toolbar

Click a slide on the storyboard and press the button on the Storyboard Toolbar. If you want to remove applied

album styles from all the slides on the storyboard, hit the button.
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2. Using the storyboard express menu

Selecting the Clear/Clear All option

Right-click a slide on the storyboard and choose the Clear option of the Express Menu to remove the applied album

style. If you want to remove album styles from all of the slides on the storyboard, select the Clear All option of the same

express menu.

Selecting the Edit option

Right-click a slide on the storyboard and choose the Edit option of the Express Menu to open the Edit window. Click

the Style tab in the right part of the window and press the Clear button. After that hit the Done button to close the

Edit window.

Adding Text to Single Photos

Along with other editing operations you can also add text to a certain slide on the storyboard, thus e.g. explaining what is

displayed there or commenting on the image. To do that first of all make sure that the Photos Tab is pressed, then click a slide

on the Storyboard and hit the button on the Storyboard Toolbar. You can also do it selecting the Edit option of the

Express Menu or simply double-clicking the slide palette with image on it. After that the following window will be opened:

Click the Text tab on the right-hand side of the Edit window. Select a text sample within the

Styles field and press the Add button shown in the figure above. After that a text rectangle

will appear within the Preview Area. You can also apply another text style to the same

text rectangle if you right-click any text sample situated in the Styles field and select the

Apply Style option of the express menu displayed in the figure to the right.

Note: it's also possible to delete or rename a text style or change some

settings of a style and save it as a new sample using express menu of the

Styles field.
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To enter the desired text, you should click the left mouse button twice or right-click the text rectangle and

select the Edit Text option of the Express Menu. Then type in what you want.

Note: use the and buttons to go to the previous and next slide situated on the storyboard.

Changing Text Position

If you'd like to move the text rectangle without changing its

proportions, direct the mouse cursor to it and the cursor will

turn into the . Then without releasing the mouse button,

move the text rectangle in the direction you need.

In order to change the proportions of the text rectangle,

direct the mouse cursor to one of the black squares and it

will turn into a hand like this . Without releasing the

mouse button, drag it in any direction.

You can also rotate the text rectangle. To do that click the

green circle with the left mouse button, the mouse cursor will change into a round arrow - - click the mouse button and,

without releasing it, drag it to change the text orientation.

Changing Text Settings

It's also possible to adjust text settings within the Settings field of the edit window. Here there are four settings groups that can

be selected by pressing one of the buttons .

Font Settings

Font - the text font-face used in the text effect. You can select a

font-face from the drop-down list.

Size - the text font-size used in the text effect. You can either

select a value from the drop-down list or enter it manually using

the keyboard.

Style - the text font style used in the text effect. You can select B

for bold text, I for italicized text and U for underlined text.

Alignment - the text position in the rectangle box that surrounds

the text effect.

Pen Settings

Color - the color used for the text edge.

Width - the thickness of the text edge (0 value will display no

edge, 100 is the maximal value for the edge property).

Opacity - the transparency of the color (can differ from 0 - full

transparency - to 100 - not transparent color).
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Brush Settings

Style - the style of the main filling used in the text. Can be Solid

(no color change throughout the filling), Gradient (smooth color

change from one selected color to the other), Hatch (a pattern

composed of two selected colors) and Texture (an image used

as a filling for your text).

Color - the color or the colors (for Gradient and Hatch) used

for the main text filling.

Opacity - the transparency of the colors (can differ from 0 - full

transparency - to 100 - not transparent color).

Shadow Settings

Draw Shadow - is used to switch the text shadow display on and

off. If marked the below properties will be available.

Color - the color of the shadow.

Opacity - the transparency of the shadow colors (can differ from

0 - full transparency - to 100 - not transparent color).

Blur - the text shadow smearing (0 being the Blur absense, 100

marking the maximum Blur value).

Offset X - the horizontal offset of the shadow in relation to the

text itself (positive values move the shadow to the right of the text, negative values move the shadow to the left of the

text).

Offset Y - the vertical offset of the shadow in relation to the text itself (positive values move the shadow above the text,

negative values move the shadow below the text).

Removing Added Text

To remove text from the slide click it within the Preview Area of the Edit window and press the

Clear button situated at the bottom of the Text tab.

You can remove text also using the Express Menu of the Preview Area. To do that right-click the

text rectangle and select the Remove option.

You can also simply left-click the text rectangle and press the Del key on your keyboard.

Note: after closing the Edit Photos window the sign will appear in the right upper corner of the slide

on the storyboard meaning that you have already edited this image.
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Changing Properties of Single Photos

To adjust properties of the image file you added to the Storyboard, click a certain slide and press the Edit button situated on

the Storyboard Toolbar or right-click it and select the Edit option of the Express Menu or simply double-click the necessary

slide on the Storyboard. After that the Edit Photos window will be opened.

Within the General tab of this window you can change the duration of the selected photo and transition between it and the

next photo, as well as image position within the slide palette, and adjust its properties.

Duration Field

By dragging the slider cursor or entering necessary values you can

set a duration value for the photo displayed in the Preview

Area and for the transition that follows it.

The values shown in rectangles are given in seconds. If you type

in the zero value, the transition will disappear from the

storyboard. The minimum value for photo duration is two

seconds.

To apply the same duration to all of the photos or transitions on

the storyboard, press the appropriate Apply to All button.

Position Field

Within this field it's possible to move the image along the X and Y

axis by entering the value you need into the appropriate boxes or

using the arrows nearby.

You can also zoom in or out your image if you set a zoom value

different from the default one (that is 1,00). Setting a negative

value (to the left from the default cursor position) will zoom out
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the image, whereas a positive value (to the right from the default cursor position) will zoom it in.

The Preview Area can also be used to set the zoom value or change image position. Just direct your mouse cursor to one of

the black squares and it will turn into a diagonal arrow - - and, without releasing the mouse button, drag it in any direction in

order to zoom the image in or out. When you hover the mouse cursor over the image it will change to for you to be able to

change the image position within the slide palette.

In order to cut some part of the image and zoom it in, click the

Crop button and the rectangle with black squares in its corners that

surrounds the entire image will disappear. Direct the mouse cursor

to the Preview Area, click the left mouse button within it and

drag it, without releasing the mouse button, to capture a certain

image area inside the rectangle. Then press the Apply button if

you are sure you highlighted the image area you need.

Note: the Apply button is disabled, until you mark an image

area to be cropped.

After that the image part you marked will be displayed in the

Preview Area. If you want the rectangle surrounding the whole

image to be shown again, press the Cancel Crop button that will be seen after hitting the Crop button.

If you'd like to return to the original position, size and appearance of the image, use the Reset button.

Adjust Field

Drag the appropriate slider cursor or enter necessary value to

make adjustments to image brightness, contrast and gamma.

Brightness is the relative lightness or darkness of the color,

usually measured in levels. So, you can adjust the tonal range of

an image.

Contrast is the difference in visual properties that makes an

object in an image distinguishable from other objects and the

background.

Gamma measures the brightness of midtone values and modifies the pixel values in an image. A higher gamma value yields an

overall lighter image.

To set the brightness, contrast or gamma value automatically, use the Auto button. If you'd like to return to the original image

properties, use the Reset button.

Note: after closing the Edit Photos window the sign will appear in the right upper corner of the slide

on the storyboard meaning that you have already edited this image.
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Creating DVD

The process of DVD creation includes the following steps:

1. Selecting DVD menu style that will represent the whole disc contents and help you to navigate through the created

slideshow albums.

2. Building DVD, which involves checking the project settings, choosing an appropriate disc type and compiling all the data

to the DVD structure.

3. Burning the resulting DVD video files to disc.

Selecting DVD Menu Style

AVS Slideshow Maker offers you a variaty of ready-made DVD menu templates. To see all of them press the DVD Menu Tab

of the Files and Styles Area.

The first DVD menu style will be automatically loaded by default. But you can change it any time you want. As soon as you

choose the menu style that corresponds to the albums contents best, double-click it and the selected style will be displayed

within the Preview Area. For this purpose you can also use the Express Menu by right-clicking the necessary menu style and

selecting the Apply Menu Preset option.

Within the Preview Area you can see all the created albums with the first slide from each album used as thumbnail. To

navigate through the created DVD menu pages you can use the tabs situated in the lower part of the Preview Area or the

white arrow shown in the figure above. Select any album you want to preview with the mouse cursor and click the Video tab.
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Use the playback controls at the bottom of the Preview Area to navigate through the entire slideshow and make playback

adjustments.

Building DVD

As soon as you are sure that all the photos you wanted to burn are added to the created albums, every image is properly edited,

all the styles are applied, you can save your current project and build DVD by pressing the appropriate button on the Top

Toolbar or using the appropriate option of the File section of the Main Menu. You will see the following window:

Here you can view and change the project parameters: system, audio/video settings and control the space occupied by the

slideshow albums on the selected disc type. See the Project Settings chapter of the Working with Projects section for more

detail.

After you have set up all the parameters, click the Build DVD

button. The following window will be opened for you to select

a folder on your computer hard disk drive where the files of

your created DVD will be saved:

You will need to select an empty folder with enough free space

for your DVD to be created.

Note: the selected folder must

have enough free space for your

DVD: not less than 4.7 Gb for a

single layer DVD and about 8.6 Gb

for a double layer DVD. The type of

the DVD used is selected in the

Project Settings window.
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After you select the folder and click the OK button the DVD building process will be started. You will be able to see the progress

in the progress window:

You can interrupt the process clicking the Stop button although in this case the disc menu will not be created.

When the DVD building process is over, the window will appear suggesting your burning the created DVD folders to a disc:

Press Yes to burn the resulting DVD folders to a disc or click No to close the message window.

Burning Disc

After building DVD process is over, the window will appear suggesting your burning the created DVD folders to a disc:

Click the Yes button to write the created DVD folders to a disc using the program internal burning engine. You will see the

following window:
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Select the necessary disc drive if you have several from the drop-down box, insert a DVD disc and click the Start burning!

button to record your DVD disc. You can also tick the Verify disc box to check whether the disc has been flawlessly created.

Note: make sure that the disc you use is empty, otherwise all existing data will be erased from it.
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